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IMPORTANT NOTICE 

All statements, technical information and recommendations in this document which relate to the 

products supplied by Meggitt Sensing Systems are based on information believed to be reliable, but 

unless otherwise expressly agreed in writing with Meggitt SA, the accuracy or completeness of such 

data is not guaranteed. Before using this product, you must evaluate it and determine if it is suitable 

for your intended application. Unless otherwise expressly agreed in writing with Meggitt SA, you 

assume all risks and liability associated with such use. Meggitt Sensing Systems takes no 

responsibility for any statements related to the product which are not contained in a current English 

language Meggitt Sensing Systems publication, nor for any statements contained in extracts, 

summaries, translations or any other documents not authored and produced by Meggitt Sensing 

Systems. 

 

 

 

EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the 

European Community, USA or other countries. Each recipient of this document is responsible for 

ensuring that the transfer or use of any information contained in this document complies with all 

relevant export control regulations. ECN N /A. 

 

 

 

COPYRIGHT 

Copyright © Meggitt SA, 2014 

All rights reserved 

Published and printed by Meggitt SA in Fribourg, Switzerland 

The names of actual companies and products mentioned  

herein may be the trademarks of their respective owners. 

The information contained in this document is subject to change without notice.  

This information shall not be used, duplicated or disclosed, in whole or in part,  

without the express written permission of Meggitt Sensing Systems. 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight ® software from Meggitt Sensing 

Systems. It is applicable to all VibroSight-based condition monitoring and machinery protection 

systems using the versions of software described by this document, namely: 

 VibroSight software version 2.11.4 (CD part number 609-004-000-024). 

This document contains information about changes to the software since the previously released 

version (VibroSight 2.11.3), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight software data sheet 

        (MSS document ref. 660-020-005-213A) 

 Getting started with VibroSight installation guide 

        (MSS document ref. 660-010-006-216A) 

 VibroSight help 

 XMV16 / XIO16T extended vibration monitoring card pair data sheet 

        (MSS document ref. 660-020-010-207A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in 

earlier versions of the software: 

 VibroSight 2.9.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.1 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.2 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.4 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.5 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.6 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.7 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.1 (MSS document ref. 660-010-013-201A) 

 VibroSight 2.11.0 (MSS document ref. 660-010-013-203A) 

 VibroSight 2.11.1 (MSS document ref. 660-010-013-204A) 
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 VibroSight 2.11.2 (MSS document ref. 660-010-013-205A) 

 VibroSight 2.11.3 (MSS document ref. 660-010-013-206A). 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 

 

Version identifiers 

A complete VibroSight software product version number has four components x.x.x build x (or x.x.x.x) 

that provide the following information: 

 Major release identifier: x.x.x build x (or x.x.x.x) 

 Minor release identifier: x.x.x build x (or x.x.x.x) 

 Update identifier: x.x.x build x (or x.x.x.x) 

 Build identifier: x.x.x build x (or x.x.x.x) 

The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 cards that are designed for operation with the VibroSight 

software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the CPUR card (for configuration only). 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 
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1. Licensing 

In general, the licence key required to enable purchased product options remains unchanged between 

update level releases. For example, from version 2.11.3 to version 2.11.4. 

However, a new licence key is required for upgrades between major and minor version releases. 

For example, from version 2.10.x to version 2.11.x. 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See 7 Customer support. 

 

 

2. Features 

 VibroSight Configurator 

2.1. Leading and trailing whitespace characters are automatically removed in 
serial numbers 

Leading and trailing whitespace characters (spaces or tabs) are no longer accepted as valid 

characters in the serial numbers entered in the Serial Number field for the various devices (XMx16 

cards) in a VibroSight configuration. 

For existing VibroSight systems that use leading and trailing whitespace characters in device serial 

numbers, these characters will be ignored and the VibroSight configuration and database will be 

updated to remove these characters the next time that the configuration is saved or activated. 

This eliminates the possibility of entering device serial numbers that are not recognised due to 

whitespace characters in a configuration, which will allow automatic device discovery (Connection 

Mode: Automatic Discovery) to automatically detect and use the IP address that has been configured 

for the device. 
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3. Solved problems and bug fixes 

General 

3.1. Improvements and bug fixes 

General stability improvements and multiple bug fixes across the various VibroSight 2.11.4 software 

modules. 

 

3.2. Problems with VibroSight OPC servers 

General problems configuring and working with VibroSight OPC Servers. 

For example, problems creating and configuring a VibroSight OPC Server, and exporting the 

published measurements to a CSV file. 

 

3.3. Problems with spectra published by VibroSight OPC servers 

A VibroSight OPC Server publishes spectra using the data type VT_ARRAY_R4 (an array of scalar 

values). In fact, three separate arrays are used for amplitude, phase and frequency, with the number 

of elements in each array being the number of lines in the spectra + 1. 

However, published spectra were incorrect as the length of the amplitude array was wrong (off by 1) 

and the x-axis unit used for order tracked data was Hz (rather than nX). 

 

 

 VibroSight Mimic 

3.4. Changes to VibroSight configurations not being propagated 

Under certain circumstances, changes made to a VibroSight configuration were not propagated to 

VibroSight Mimic. 

Depending on the configuration changes, VibroSight Mimic could stop responding (no values and 

timer runs out) and may not recover, even after stopping and restarting VibroSight Mimic. In addition 

VibroSight Mimic could report reference errors (for example, “The entity [1474148408;25] has a 

revision that is out of date” ) with associated errors reported by VibroSight Server. 

In addition, the “configuration has changed” messages have been improved in order to provide more 

useful information to the user. 
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 VibroSight System Manager 

3.5. VibroSight System Manager stops responding 

Under certain circumstances, VibroSight System Manager stopped responding and was required to be 

be restarted in order to continue. For example, when trying to establish a connection to a remote 

VibroSight Server, or when connected to a VibroSight Server that becomes unavailable (exited 

(closed) by the user or due to a network infrastructure issue such as an unplugged cable). 

 

3.6. Database operations using external compression / file archiving tools 

The option (-c) in the database Copy and the database Backup commands to use a third-party 

compression / file archiving software tool was not working correctly, so the option (-zip) to use the 

integrated (native) support had to be used when database compression was required. 

NOTE: In VibroSight 2.11.4, the option to use a third-party compression / file archiving 

software tool has been changed from -c to –custom-zip-command. 

 

This bug was due to the command-line parser not correctly parsing commands with options that 

contained sub-options. The command-line parser has now been reworked to support sub-options and 

be more consistent with standard parameter interpretation in Microsoft Windows. 

NOTE: The improved command-line parser in VibroSight 2.11.4 may not be compatible 

with existing data management batch (.bat) files using the database Copy and 

database Backup commands. 

 

Changes to the command-line parser in VibroSight 2.11.4 include: 

 Parameters use the space character as a separator. 

 For parameters using spaces, the whole parameter must be enclosed in double quotation 

marks. 

For example: -p="This is only one parameter" 

 For parameters containing quotation marks, the backslash character can be used to escape 

(that is, allow) these quotation marks. 

For example: -p="This is an \“example\” parameter" 

Note: Do not use the backslash character to escape the double quotation marks that are used 

to contain a parameter containing spaces. 

For example: -p="C:\This is my path" 

 The option to use a third-party compression / file archiving software tool has been changed from 

-c to –custom-zip-command. 

For example: –custom-zip-command="This is my custom command" 

Note: The use of the equals sign is mandatory. 

 

The option (-zip) to use the integrated (native) support and the option (–custom-zip-command) to 

use a third-party compression / file archiving software tool are mutually exclusive. 
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3.6.1. Example command-line tool usage to copy a database with external 
compression / file archiving using 7-Zip 

7-Zip is an open-source file archiver that has achieved good results with VibroSight databases. That 

is, much improved data compression compared to the (native) data compression available with the -

zip option. 

Example command-line tool command to copy a VibroSight database: 

"C:\Program Files (x86)\Meggitt\VibroSight 2\Bin\VibroSightDataCopy.exe" -

s="C:\VibroSight Data\Rotorkit\Rotorkit.vssrvdb" -d="C:\VibroSight 

Data\Backup" -file=CompressRotorkit -t -a -r -datatype=all -hierarchy=all -

all -log -sum -custom-zip-command="\"C:\Program Files\7-Zip\7z.exe\" a -t7z 

-mx9 {ARCHIVE}.7z {FILES}" -del 

 

The equivalent 7-Zip command line in the Command line of the VibroSight System Manager Copy 

wizard, under Use a custom compression tool (when Compress Copied files is selected) is: 

"C:\Program Files\7-Zip\7z.exe" a -t7z -mx9 {ARCHIVE}.7z {FILES} 

Unlike the command-line tool command, the VibroSight System Manager Copy wizard does not need 

to escape the quotation marks used within the parameter for the -custom-zip-command. 

 

Notes: 

In the example command-line tool command to copy a VibroSight database, 

\"C:\Program Files\7-Zip\7z.exe\" a -t7z -mx9 {ARCHIVE}.7z {FILES} 

is the actual 7-Zip command to be executed, which is contained in double quotation marks (“) with its 

options. 

The 7-Zip command requires escaped double quotation marks (\”) in order to escape the 7-Zip path 

and command, and indicate to the command-line parser that the 7-Zip command contains its own 

options. 

 

 

3.6.2. Example command-line tool usage to copy a database with external 
compression / file archiving using WinRAR 

WinRAR is a shareware file archiver and data compression utility that has achieved good results with 

VibroSight databases. That is, improved data compression compared to the (native) data compression 

available with the -zip option. 

Example command-line tool command to copy a VibroSight database: 

"C:\Program Files (x86)\Meggitt\VibroSight 2\Bin\VibroSightDataCopy.exe" -

s="C:\VibroSight Data\Rotorkit\Rotorkit.vssrvdb" -d="C:\VibroSight 

Data\Backup" -file=CompressRotorkit -t -a -r -datatype=all -hierarchy=all -

all -log -sum -custom-zip-command="\"C:\Program Files 

(x86)\WinRAR\Winrar.exe\" a {ARCHIVE}.rar {FILES}" -del 
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The equivalent WinRAR command line in the Command line of the VibroSight System Manager Copy 

wizard, under Use a custom compression tool (when Compress Copied files is selected) is: 

"C:\Program Files (x86)\WinRAR\Winrar.exe" a {ARCHIVE}.rar {FILES} 

Unlike the command-line tool command, the VibroSight System Manager Copy wizard does not need 

to escape the quotation marks used within the parameter for the -custom-zip-command. 

 

Notes: 

In the example command-line tool command to copy a VibroSight database, 

\"C:\Program Files (x86)\WinRAR\Winrar.exe\" a {ARCHIVE}.rar {FILES} 

is the actual WinRAR command to be executed, which is contained in double quotation marks (“) with 

its options. 

The WinRAR command requires escaped double quotation marks (\”) in order to escape the WinRAR 

path and command, and indicate to the command-line parser that the WinRAR command contains its 

own options. 
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4. Known issues 

4.1. Changing a VibroSight Server’s maximum RAM cache size when DSNs are 
not used 

Since VibroSight 2.9.7, a VibroSight Server database no longer requires a data source name (DSN), 

so it is no longer required to use the ODBC Data Source Administrator to manage the underlying 

connection to the Sybase SQL Anywhere 11 database (which provided convenient access to the start 

line command that is used to start the SQL Anywhere 11 server). 

NOTE: dbeng11.exe -ch 600m is the default command used to start the SQL 

Anywhere 11 server, where the -ch 600m option specifies that a maximum RAM 

cache size of 600 MB should be used. (This option limits the underlying SQL 

Anywhere’s database server cache during automatic cache growth.) 

However, for more complex machinery monitoring applications and larger 

databases, it is recommended that a maximum RAM cache size of 2000 MB 

(-ch 2000m) is used, in order to improve the overall performance of the VibroSight 

machinery monitoring system. 

 

When a DSN is not used with a VibroSight Server database, the settings usually written to the DSN 

using the ODBC Data Source Administrator are managed by the VibroSight Server itself and stored in 

the VibroSight Server configuration file (*.vssrvcfg). However, this means that the specification of 

the maximum cache size to be used by the VibroSight Server database is not as convenient to access 

by the user. 

Presently, the default command used to start the SQL Anywhere 11 server will be used unless: 

 In VibroSight Configurator, when saving the configuration as a server / database, the Configure 

advanced settings option is used to enter a different SQL database start line command. 

 In VibroSight System Manager, when copying the database, the Configure advanced settings 

option is used to enter a different SQL database start line command. 

So when DSNs are not used with a VibroSight Server database, the VibroSight Server configuration 

file (*.vssrvcfg) must be edited manually if it is necessary to change the SQL database start line 

command after a VibroSight Server database has been created or copied: 

1. Exit all VibroSight software modules (clients and servers) that use the VibroSight Server 

database to be modified. 

2. Use a text editor program to open the VibroSight Server configuration file (*.vssrvcfg) and 

search for the text string dbeng11.exe. 

3. Edit the StartLine="dbeng11.exe -ch 600m" command in the configuration file to use the 

new required maximum cache size. 

For example, StartLine="dbeng11.exe -ch 2000m", then save the file. 

4. Restart the VibroSight Server. 

 

If the StartLine="dbeng11.exe -ch 600m" command cannot be found in the VibroSight Server 

configuration file being used, then a “dummy” copy of the VibroSight Server database should be 
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created using VibroSight System Manager’s Database Copy command with the Configure advanced 

settings option selected. A “dummy” VibroSight Server configuration file created in this way will include 

the SQL database start line command and can be used as an example to edit the VibroSight Server 

configuration file being used. (After which, the “dummy” files should be deleted.) 

NOTE: It is highly recommended to make a backup copy of the VibroSight Server 

configuration file being used before manually editing it. 

Such manual edits must be done carefully in order to ensure that the tags and 

delimiters used in the VibroSight Server configuration file are used correctly. 

 

4.2. Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time 

or Local computer time and the site time or local computer time is subsequently changed on the 

relevant computer (for example, using Windows > Control Panel > Date and Time), this change is not 

reflected in the VibroSight Vision user interface until the user clicks on the Timestamp displayed in 

the VibroSight Vision status bar. 

 

4.3. Small “holes” in plotted data for larger VibroSight Vision projects when 
viewing live data 

Depending on the complexity of a VibroSight application and the performance of the computer running 

the VibroSight software, the responsiveness of VibroSight Vision can decline under certain situations 

and affect the display of plots when viewing live data. 

In particular, this performance issue has been seen with larger VibroSight Vision projects containing 

many open plots using live data. It is typically characterised by plots being displayed with small “holes” 

in the data, corresponding to when the computer has reached its performance limits. 

If this behaviour is seen, the recommended workaround is to: 

 Reduce the number of active plots in the VibroSight Vision project in order to reduce the 

computational load, as only the currently displayed (foreground) plots are constantly 

refreshed. Plots that are hidden or minimized (background) are not active and will only be 

refreshed when they become visible again. 

 If it is necessary to view historical data at the same time, consider using a separate VibroSight 

Vision session to work with the historical data, preferably on a different computer. 

 

4.4. Missing data for XMV16 and XMVS16 cards 

When the order-tracked sampling mode is being used, XMV16 and XMVS16 cards have been seen to 

disappear (drop out) and produce no data for periods of 10, 20 or 30 seconds. After which, the card 

usually reappears without any intervention and normal operation resumes. 

This issue is being investigated and appears to be a XMV16 and XMVS16 card firmware problem that 

is related to transitions in the input speed signal from “zero speed” to “non-zero speeds”. 
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4.5. VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 

 

4.6. Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new 

server instances with VibroSight 2.9.6 or later. 

However, existing server instances may be non-compliant (too long) and no longer run after an 

upgrade of the VibroSight software. In such cases, the server instance name should be manually 

edited in the VibroSight configuration file (*.vssrvcfg or *.config) to be 18 characters or less. 

Changes may also be required in any VibroSight software that references the server instance name, 

for example, associated VibroSight Vision Projects. 

For automated database copies that append a timestamp (_yyyyMMddHHmmss) to the Server 

instance name, the number that remain available for VibroSight Server instance names is deduced to 

3 characters. Alternatively, the server instance name can be shorted after the database copy is 

complete. 

 

4.7. VibroSight client connections to local and remote VibroSight Servers are 
mutually exclusive 

When a VibroSight Server is running on a (local) computer, a VibroSight client, such as VibroSight 

Configurator or VibroSight Vision running on the same (local) computer cannot connect to a VibroSight 

Server running on a different (remote) computer. 

 

4.8. VibroSight Servers listen to a single IP address 

VibroSight Servers use one specific IP address for connections to VibroSight clients. This IP address 

can be set to any of the available LAN adapters or logical addresses on the host computer, such that 

all traffic is directed through this address. However, this prevents concurrent connections from 

VibroSight clients running on other computers through different IP addresses. 

 

4.9. Gaps in logged Modbus data 

When data logging with pre-trigger is used (for example, a time-based data logging rule with 

Pre Logging selected) or database operations such as a database copy or a database purge 

command occur at the same time as standard data logging, gaps can appear in the Modbus data that 

has been logged at a standard rate. 
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These gaps in Modbus data are related to the computation of alarms when data is written to the 

database, which can be slow and can prevent some subsequent Modbus data from being handled 

correctly, especially when VibroSight Server is busy with other data intensive tasks. 

 

4.10. Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, 

UTC time or Local computer time, all other VibroSight client software modules continue to display 

timestamps in local computer time only (that is, the date and time according to the local clock of the 

computer running the VibroSight software module). 

 

4.11. Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always 

update correctly to show all of the devices (VM600 cards) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a 

refresh (using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

 Wait a few minutes and refresh again. 

 Restart VibroSight System Manager. 

 

4.12. VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight 

Mimic client software module for mimics (that were previously available in VibroSight Vision). As a 

result, VibroSight Vision mimics created with VibroSight 2.9.7 or earlier are not compatible with 

VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client 

software module. As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are 

not compatible with VibroSight 2.11.0 or later. 

 

4.13. VibroSight OPC servers 

After certain changes to a VibroSight configuration, the VibroSight OPC Server can stop publishing 

data to the OPC client. 

If this behaviour is seen, the recommended workaround is to: 

 Unpublish and republish the VibroSight OPC Server 

In VibroSight System Manager, in the Actions window, under OPC Server, use the Unpublish 

command and the Publish command. 

 Re-establish the OPC client. 

Use the third-party OPC client to disconnect and reconnect to the VibroSight OPC Server. 
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Depending on the nature of the problem, one or both of the above actions can be required to resolve 

the problem. 

 

 

 

  



     

   
 

 

     

 

     
 18 / 34 Release Notes VIBROSIGHT-RN/E (660-010-013-207A) 

Release 2.11.4 – April 2014 
 

     
 

5. Compatibility 

NOTE: Refer also to the latest version of the  Getting started with VibroSight 

installation guide or the  VibroSight software data sheet for further information 

on VibroSight’s prerequisites and compatibility. 

 

As part of the VibroSight software installation process, the installation wizard will automatically check 

to see if the “Microsoft Visual C++ Redistributable Package” (see section 5.1.6) and the “OPC Core 

Components Redistributable (x86)” (see section 5.1.7) are available on the computer. 

If these items have not previously been installed and they are required by the VibroSight installation’s 

application, then the VibroSight installation wizard can be used to install them. 

 

5.1. VibroSight software 

VibroSight 2.11.4 is an update version release in the 2.x.x series and replaces VibroSight 2.11.3. 

Compatibility with existing databases is achieved using the database  Update tool (from 

VibroSight System Manager’s  Database tools) which supports the continued used of 

configurations and data from previous versions. See 6.2.1 Updating the internal structure of a 

VibroSight database. 

 

5.1.1. Microsoft Windows operating systems 

VibroSight 2.11.4 is compatible with 32-bit versions and 64-bit versions of Microsoft ® Windows ® 

operating systems. 

NOTE: Since VibroSight 2.9.0, VibroSight can run on 64-bit versions of Windows in order 

to help eliminate memory and performance issues that can occur due to the 

limitations of the 32-bit memory space. 

However, VibroSight 2.11.x remains 32-bit software that runs on x64 Windows in 

the same manner as it does on 32-bit windows, that is, VibroSight is "x64-

compatible" software (not "native x64" software). 

 

See the appendix of this document for detailed information on VibroSight software and Windows 

operating system compatibility. 
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5.1.2. Microsoft .NET Framework 

For most Windows operating systems, VibroSight 2.11.4 requires that the Microsoft .NET 

Framework 4.5 is installed on the computer.  

NOTE: Microsoft .NET Framework 4.5 is required since VibroSight 2.9.4. 

Microsoft .NET Framework 4 (Standalone Installer) is required for VibroSight 2.9.2 

and 2.9.3. 

Microsoft .NET Framework 3.5 SP1 is required for VibroSight 2.9.1 or earlier. 

 

See the appendix of this document for detailed information on VibroSight software’s Microsoft .NET 

Framework requirements. 

 

5.1.3. Sybase SQL Anywhere 11 software 

VibroSight uses the Sybase ® SQL Anywhere 11 database software in its standard configuration. 

VibroSight 2.11.4 remains compatible with the previously deployed version of SQL Anywhere, namely 

SQL Anywhere version 11.0.1.2044. 

NOTE: VibroSight requires the 32-bit version of SQL Anywhere 11 on both 32-bit and 64-

bit Windows operating systems. 

It is strongly recommended that only the 32-bit version of SQL Anywhere 11 is 

installed on the computer running VibroSight. 

NOTE: Updating SQL Anywhere to version 11.0.1.2867 is mandatory in order to avoid 

potential memory issues (fixed by Sybase). A software update (patch) included on 

the Sybase CD must be run in order to update Sybase SQL Anywhere from version 

11.0.1 to version 11.0.1.2867: SA11_Full_Win32+x64.1101_2867_EBF.exe. 

See 6.3 Upgrading the Sybase SQL Anywhere 11 software. 

 

5.1.4. VM600 CMS software 

The VM600 CMS software from Meggitt Sensing Systems uses Sybase SQL Anywhere 8. Both 

Sybase SQL Anywhere 8 (VM600 CMS) and Sybase SQL Anywhere 11 (VibroSight) can be installed 

on the same computer. 

However, while SQL Anywhere 8 and SQL Anywhere 11 can be installed on the same computer and 

run at the same time for standard database operations, certain administrative tasks are mutually 

exclusive and may block one another. 

More specifically, all operations that refer to Sybase ISQL (a command-line Interactive SQL utility) in 

the background could be directed to the wrong version of Sybase SQL Anywhere. For example, this 

impacts all user operations and system operations involving the creation, copying and updating of 

databases. 

NOTE: It is recommended to install and use VibroSight on a computer that does not have 

the VM600 CMS software installed. 
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5.1.5. SIMATIC Step 7 software 

The SIMATIC Step 7 software from Siemens typically uses Sybase SQL Anywhere 9. Both Sybase 

SQL Anywhere 9 (SIMATIC Step 7) and Sybase SQL Anywhere 11 (VibroSight) can be installed on 

the same computer. 

However, while SQL Anywhere 9 and SQL Anywhere 11 can be installed on the same computer, they 

cannot run at the same time. 

More specifically, if SIMATIC Step 7 and VibroSight are both installed, certain administrative tasks, 

such as all user operations and system operations involving the creation, copying and updating of 

databases, may not work correctly. If this behaviour is seen, the recommended workaround is to 

manually change or remove the SQLANY environmental variable in order to allow VibroSight to work 

correctly. 

Note: The SQLANY environment variable is used to contain the directory where Sybase SQL 

Anywhere is installed. 

NOTE: It is recommended to install and use VibroSight on a computer that does not have 

the SIMATIC Step 7 software installed. 

 

5.1.6. Microsoft Visual C++ Redistributable Package 

The Microsoft Visual C++ Redistributable Package is required in order to install and register the Visual 

C++ libraries required by a VibroSight OPC server. 

If this package does not already exist on the computer, then the VibroSight installation wizard will 

install it automatically. (The package is included in the ISSetupPrerequisites folder on the 

VibroSight CD.) 

NOTE: The Microsoft Visual C++ Redistributable Package is required since 

VibroSight 2.9.4, if VibroSight OPC servers are being used. 

The 32-bit version of the package (“vcredist_x86.exe”) is installed on both 32-bit 

and 64-bit Windows operating systems, as the VibroSight OPC server is a 32-bit 

application. 

 

5.1.7. OPC Foundation OPC Core Components Redistributable 

The OPC Core Components Redistributable is required in order to configure and run VibroSight OPC 

clients and OPC servers correctly: the redistributable must be installed on OPC client computers in 

order to allow connections to remote OPC servers and it must be installed on OPC server computers 

in order to allow OPC clients to browse for running OPC servers. 
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If this redistributable does not already exist on the computer, then the VibroSight installation wizard 

will install it automatically. (The redistributable is included in the ISSetupPrerequisites folder on the 

VibroSight CD.) 

NOTE: The OPC Core Components Redistributable is required since VibroSight 2.9.4, if 

OPC clients or OPC servers are being used. 

The 32-bit version of the package (“OPC Core Components Redistributable (x86)”) 

is installed on 32-bit Windows operating systems and the 64-bit version of the 

package (“OPC Core Components Redistributable (x64)”) is installed on 64-bit 

Windows operating systems. 

 

 

5.2. VM600 cards 

5.2.1. Firmware 

There are no firmware updates for VM600 cards corresponding to VibroSight 2.11.4. 

The latest firmware for the CPUR remains: 

 Applications:  applications-640-012-001-003.tgz 

 Base System: base-system-640-011-001-003.tgz. 

The latest firmware for the XMC16, XMV16 and XMVS16 remains: 

 Applications:  applications-640-010-001-009.tgz 

 Base System: base-system-640-003-001-010.tgz. 

Therefore, for current versions of the VibroSight-compatible VM600 cards, no firmware upgrades are 

required. 
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6. Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards) before starting a VibroSight system upgrade, in order to 

establish if any firmware updates are also required. 

See 6.4.2 Updating the firmware using VibroSight System Manager. 

 

6.1. VibroSight software user settings 

The VibroSight Software generates and uses some files on the hard disk of the computer running 

VibroSight to keep track of user-configurable settings, so that these settings are remembered and 

applied for the VibroSight installation. 

These settings files have an .xmssettings file name extension and on a computer running 

Windows 7, can be found here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight 2, where username is the Windows 

account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default 

settings for VibroSight Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 

• For a computer on which VibroSight was previously installed, an update, upgrade 

or a re-installation of VibroSight will continue to use the previous defaults recorded 

in the .xmssettings files. 

• For a computer on which VibroSight was not previously installed, the installation 

of VibroSight will generate and use new .xmssettings files, which use the latest 

VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 

settings file, which uses the latest VibroSight software defaults. 
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6.2. Upgrading the VibroSight software 

NOTE: Since VibroSight 2.9.6, VibroSight Server instance names are limited to 

18 characters (previously, it was 27). So VibroSight installations with VibroSight 

Server instance names of more than 18 characters will experience problems with 

VibroSight 2.11.x until the existing VibroSight Server instance names (and any 

references to them) are manually edited to be 18 characters or less. 

See 4.6 Length limitation of VibroSight Server instance names. 

 

1. If it is not necessary for the VibroSight-based system to remain operational during the upgrade 

procedure, back up any important (required) VibroSight databases in the following way: 

 Exit all VibroSight software modules (clients and servers) – no VibroSight software modules, 

such as Vision, Configurator or Server, should be running. 

 Copy the files (*.vssrvdb, *.vssrvcfg and optionally, *.log) from the directory 

where your database files are located to another location, for example, to a specific backup 

directory. 

 NOTE: The default data (data path) directory is C:\VibroSight Data 

 

Or if it is necessary for the VibroSight-based system to remain operational for as long as 

possible during the upgrade procedure, back up any important (required) VibroSight 

databases in the following way: 

 Exit all VibroSight software modules (clients) – no VibroSight software modules, such as 

Vision or Configurator, should be running. 

 Start VibroSight System Manager and use the database  Backup tool from VibroSight 

System Manager’s  Database tools, and follow the instructions presented by the 

Database Backup Wizard. 

 

 NOTE: It is necessary to be logged in to System Manager as ‘Admin’ in order to have the 

user rights to access the database tools: 

Select your  VibroSight Host (computer) in the System Explorer tree structure 

and click  Login (from VibroSight System Manager’s  Access Rights 

tools). 

Refer also to the Backing up a database topic in the  VibroSight help. 
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2. Make backup copies of any important (required) VibroSight Vision projects in the following way: 

 Create an archive file (for example, *.zip) containing all of the files (*.xml and 

*.xmsproj) in the directory where your project files are located. 

 NOTE: The default project directory is: 

C:\Documents and settings\username\My Documents 

\VibroSight\Projects 

 

3.  Ensure that no VibroSight software modules are running. 

4. Remove the currently installed version of the VibroSight software (for example,  

 VibroSight Standard Edition) using Windows Add or Remove Programs, in one of the 

following ways: 

 Click Start > Settings > Control Panel and then double-click Add or Remove Programs. 

 Or click Start, click Control Panel and then double-click Add or Remove Programs. 

5. Install the latest version of the VibroSight software by inserting the VibroSight CD into the 

CD/DVD drive of the computer and follow the instructions presented by the VibroSight 

installation wizard. 

NOTE: Refer to the  Getting started with VibroSight installation guide for detailed 

information on installing the VibroSight software – including prerequisites and 

compatibility. 

 

6. Restart VibroSight Server and ensure that the required communications are enabled. For 

example, enable card and module device drivers according to the hardware in the system: 

 For example, click Data > Acquisition > XMC16/XMV16 Card Driver. 

7. Restart VibroSight Vision and ensure that live data is being received from the hardware and 

displayed in Vision. 

8. The VibroSight system is now up and running. 

 

6.2.1. Updating the internal structure of a VibroSight database 

When VibroSight Server is started, it checks the status of the database and will automatically inform 

the user if any internal structures of the database need to be updated before proceeding. 

1. Update a VibroSight database in the following way: 

 Start VibroSight System Manager and use the database  Update tool from VibroSight 

System Manager’s  Database tools, and follow the instructions presented by the 

Database Update Wizard. 
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 NOTE: It is necessary to be logged in to System Manager as ‘Admin’ in order to have the 

user rights to access the database tools: 

Select your  VibroSight Host (computer) in the System Explorer tree structure 

and click  Login (from VibroSight System Manager’s  Access Rights 

tools). 

Refer also to the Updating a database topic in the  VibroSight help. 

 

 

6.3. Upgrading the Sybase SQL Anywhere 11 software 

VibroSight software is compatible (and extensively tested) with Sybase SQL Anywhere versions 

11.0.0 and 11.0.1. 

However, with the release of SQL Anywhere version 11.0.1.2867, Sybase has fixed some previously 

known memory issues. Therefore, it is mandatory to upgrade all VibroSight systems to this version of 

SQL Anywhere 11. 

 

Determine the version of the SQL Anywhere 11 database engine installed on a computer in the 

following way: 

1. From the Start menu, click Start > All Programs > SQL Anywhere 11 > Sybase Central. 

The Sybase Central window appears. Sybase Central is a GUI-based management tool for 

Sybase products. 

2. Click Help > About Sybase Central. 

The About Sybase Central windows appears, displaying the version information for SQL 

Anywhere 11 (and any other installed Sybase products). 

 

 NOTE: Refer also to the Determining the version of SQL Anywhere 11 installed on a 

computer topic in the  VibroSight help. 

 

If SQL Anywhere 11 version 11.0.0 is installed on the computer, it is necessary to first remove 

version 11.0.0, then install version 11.0.1 from the Sybase CD. 

If SQL Anywhere 11 version 11.0.1 is installed on the computer, simply update to version 11.0.1.2867 

by running the software update (patch) included on the Sybase CD. 
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When SQL Anywhere 11 software version 11.0.0 is installed on the computer: 

NOTE: Do not use the SQL Anywhere 11.0.1 setup to upgrade directly to software version 

11.0.1 from software version 11.0.0. Instead, it is necessary to upgrade the Sybase 

database software as follows: 

1. Remove SQL Anywhere 11.0.0, using the Windows Add or Remove Programs 

tool. 

2. Install SQL Anywhere 11.0.1, using the Sybase SQL Anywhere 11.0.1 CD. 

Refer also to the  Getting started with VibroSight installation guide for 

information on installing the Sybase software. 

 

1. Exit all VibroSight software modules (clients and servers) – no VibroSight software modules, 

such as Vision, Configurator or Server, should be running – as this also stops the SQL 

Anywhere 11 database engine. 

The  lightning icon that appears in the notification area (at the far right of the task bar) to 

indicate that a Sybase database engine is running should no longer be shown. 

2. Remove the currently installed version of Sybase SQL Anywhere 11 using Windows Add or 

Remove Programs, in one of the following ways: 

 Click Start > Settings > Control Panel, then double-click Add or Remove Programs 

 Or click Start, click Control Panel and then double-click Add or Remove Programs. 

And remove  SQL Anywhere 11. 

3. Restart the computer. 

4. Install Sybase SQL Anywhere VibroSight 11.0.1.2044 by inserting the Sybase CD into the 

CD/DVD drive of the computer and following the instructions presented by the 

SQL Anywhere 11 installation wizard. 

5. Restart the computer. 

Without this final computer restart, VibroSight Server may not be able to start the 

SQL Anywhere 11 database engine. 

 

When SQL Anywhere 11 software version 11.0.1 is installed on the computer: 

1. Update to Sybase SQL Anywhere VibroSight 11.0.1.2867 by inserting the Sybase CD into the 

CD/DVD drive of the computer, running the SA11_Full_Win32+x64.1101_2867_EBF.exe 

software update (patch) and following the instructions presented by the SQL Anywhere 11 

installation wizard. 

2. Restart the computer. 
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6.4. Updating the VibroSight hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (CPUR and 

XMx16) to be updated to the latest firmware, in order to take advantage of improvements to the 

VibroSight software. 

Updating the firmware is a special task that can, if used unintentionally or incorrectly, lead to 

malfunctioning of the device and affect proper function of data acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal 

machinery monitoring functions because its outputs (alarms and relays) can go to undetermined 

states, irrespective of how they have been configured. 

NOTE: It is highly recommended that firmware updates are only performed in accordance 

with the operating procedures for the machinery being monitored and that 

appropriate precautions are taken at the control system level (such as DCS 

or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 

order to avoid false trips of the machinery being monitored. 

 

6.4.1. VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight 2\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that 

is, XMC16, XMV16 and XMVS16 card pair firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 XMx16 

card firmware that is compatible with the version of VibroSight software being used. 
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Table 1: VibroSight software and VM600 XMx16 card firmware compatibility 

 VM600 XMx16 card firmware 

VibroSight 

software version 

CD part number 

Base-system (*.tgz) 

640-003- 

001-005 

640-003- 

001-006 

640-003- 

001-007 

640-003- 

001-008 

640-003- 

001-009 

640-003- 

001-010 

Applications (*.tgz) 

640-010- 

001-004 

640-010- 

001-005 

640-010- 

001-006 

640-010- 

001-007 

640-010- 

001-008 

640-010- 

001-009 

2.9.2 

609-004-000-012 


See note 1
 

See note 1
 

See note 1
    

2.9.3 

609-004-000-013 
      

2.9.4 

609-004-000-014 
      

2.9.5 

609-004-000-015 
      

2.9.6 

609-004-000-016 
      

2.9.7 

609-004-000-017 
   

See note 2
   

2.10.0 

609-004-000-018 
   

See note 2
   

2.10.1 

609-004-000-019 
   

See note 2
   

2.11.0 

609-004-000-020 
   

See note 2
 
See notes 2 and 

3 
 

2.11.1 

609-004-000-021 
     

See note 4
 

2.11.2 

609-004-000-022 
      

2.11.3 

609-004-000-023 
      

2.11.4 

609-004-000-024 
      

 

Notes for Table 1 (see the next page) 
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Notes for Table 1 

1. VibroSight 2.9.1 or later is not compatible with any previous versions of the VM600 card firmware as the protocol between the 

SW and the FW has changed (to improve the implementation of the card type handling between the SW and the cards, required 

for the XMVS16 card). 

2. Updating to these versions of VM600 XMx16 card firmware requires a two-step process: 

(i) VibroSight System Manager’s Change Firmware command should be used to update the base-system 

firmware (640-003-001-00*.tgz) only. 

(ii) Then the Change Firmware command should be used again to update the applications 

firmware (640-010-001-00*.tgz) only. 

3. This version of VM600 XMx16 card firmware introduces support for the direct measurement mode that is used to acquire 

direct data (digitised waveform) before an event. 

4. This version of VM600 XMx16 card firmware introduces support for the operation of a VibroSight system without an NTP 

server (NTP-free). 
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6.4.2. Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 XMx16 cards to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to 

incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only 

in systems where the firmware running on the XMx16 cards already corresponds to the latest available 

version that no firmware update is required. Therefore, it is strongly recommended to verify the version 

of firmware running on the hardware before starting a VibroSight system upgrade, in order to establish 

if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (XMx16 card) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no XMx16 cards in the tree structure or some cards are missing, verify your 

network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card selected. 

.tgz files are for VM600 cards. 

 

6. Click the Finish button to start the firmware upgrade process. 
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For XMx16 cards, the firmware upgrade process can take up to 5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks, where systems are operating with different versions of VibroSight. 

 

6.5. Final checks 

After upgrading the VibroSight software, the following checks are recommended to ensure that 

VibroSight has not been inadvertently modified and that it continues to operate as expected: 

 Use VibroSight Configurator to run a consistency check on the configuration in order to ensure 

that the configuration has not been modified by any changes to the VibroSight software, 

internal database structure and firmware for the hardware (VM600 cards). 

 Use the VibroSight Server window to check that the data acquisition, data post-processing and 

data logging settings are as expected. (Click Data > Acquisition, Data > Post-processing 

and Data > Logging and disable/enable the drivers, processing managers and logging as 

required.) 
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7. Customer support 

7.1. Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Customer support 

Meggitt SA 

Route de Moncor 4 

PO Box 1616 

CH-1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Web: www.meggittsensingsystems.com 

 

7.2. Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3. Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensingsystems.com/
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VibroSight software and Windows operating system compatibility 

 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

VibroSight software 

compatible? 

Yes, but not recommended for 

new installations as Microsoft 

support for Windows XP SP3 

ends on 08 April 2014 

Yes, but not recommended. 

Windows Server 2008 R8 

should be used instead of 

Windows Server 2008 

Yes – recommended for new 

installations 
To be announced 

 

Microsoft .NET Framework versions pre-installed on Windows operating systems 

 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

Microsoft .NET Framework 

pre-installed on Windows 

operating system 

None on XP. 

.NET Framework 2.0 on 

Server 2003 R2 

.NET Framework 3.0 .NET Framework 3.0 SP1 .NET Framework 4.5 

 

VibroSight software’s Microsoft .NET Framework requirements 

VibroSight software version 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 

VibroSight 2.9.2 and 2.9.3 .NET Framework 4 .NET Framework 4 .NET Framework 4 .NET Framework 4 

VibroSight 2.9.4 or later .NET Framework 4
 1
 .NET Framework 4.5 .NET Framework 4.5 .NET Framework 4.5 

 


